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Goals
● Create an ArcGIS Pro “Project”
● Add vector data “layers”
● Learn the basics about Map 

Projections
● Use Attribute tables (descriptive 

data)
● Symbolize attribute data
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● Subset data
● Label data
● Formatted Layer Files
● Add Raster Data
● Group data layers
● Load Mapping Services
● Geocoding



1 - using the Windows menu search 
programs option, type in “ArcGIS Pro”

2 - Select ArcGIS Pro from the list of 
Programs

3 - Click on “Map” under “Create a new 
Project”

4 - Provide a name for your project 
and take note of the location of the 
project. 

5 - Make sure you select “Create a 
new folder for this project.

3

Creating a new 
project



1 - your project will open with a map 
with no data loaded except the 
basemaps
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Creating a new 
project



1 - in the catalog “view”, double-click 
on “Databases”. You should see a 
“Geodatabase” with the same name as 
your project. 

2 - Double-click on the geodatabase 
(there should be no data present)

2 - click on the word “Project” in the 
location part of the Catalog view to 
navigate back

3 - Double-Click “Folders” and 
double-click on the folder inside (there 
should be only the geodatabase and a 
file with the extension .tbx)
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Creating a new 
project

https://desktop.arcgis.com/en/arcmap/10.3/manage-data/geodatabases/what-is-a-geodatabase.htm


1 - click on the word “Project” in the 
Catalog view location area

2 - right-click on the “Folders”

3 - select “Add Folder Connection”

4 - locate the “ArcGISProWorkshop” 
folder and click (do not double-click) 
on the “data” folder

5 - click “OK”
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Creating a new 
project



1 - In the Catalog pane, double-click 
on the data folder

2 - double-click on the 
“Bike_Rack_Locations” folder
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Creating a new 
project



1 - click once on the 
“Bike_Rack_Locations_WGS84.shp” 
shapefile* dataset.

2 - you will now see both a description 
of this dataset in the metadata tab and 
a preview of it through the preview tab

* Note: A shapefile is a common GIS 
dataset format.  
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Creating a new 
project

https://desktop.arcgis.com/en/arcmap/10.3/manage-data/shapefiles/what-is-a-shapefile.htm


1 - close the “Catalog” view by clicking 
on the x
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Creating a new 
project



1 - click on the “Insert” menu

2 - click on “New Map” option

3 - select “New Map” in the dropdown 
options

A new blank map with only a basemap 
should appear

* Map projections are methods for 
representing the three-dimensional 
sphere of the earth into a 
two-dimensional surface

Map Projections*
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Map Projections
1 - under the Map menu, click on the 
“full extent” button

Note the size of Greenland vs. the size 
of Africa. Africa is actually 14 times 
bigger than greenland. Don’t believe 
me? See 
https://mapfight.appspot.com/africa-vs-
gl/africa-greenland-size-comparison

https://mapfight.appspot.com/africa-vs-gl/africa-greenland-size-comparison
https://mapfight.appspot.com/africa-vs-gl/africa-greenland-size-comparison


1 - in Windows locate the folder called 
“ArcGISWorkshop\data\Neighbourhoo
d_boundaries” and double-click on it

2 - with the folder open, click and drag 
the “NEIGHBORHOODS_WGS84.shp” 
file into the map or contents area of 
ArcGIS pro.
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Map Projections



This map of Toronto Neighbourhoods 
should display, possibly in another 
random colour. Pay close attention to 
the shape of our map.
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Map Projections



1 - under the “Insert” menu again, 
select the “New Map” option and select 
“New Map”

A new tab will be created called 
“Map1”
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Map Projections



1 - under the “View” menu click on 
“Catalog Pane”

2 - in the “Catalog” click on the 
“Folders” area, navigate to the 
following location “data” → 
“Neighbourhood_boundaries” → 
“UTM6”

3- click and drag the 
“NEIGHBOURHOODS_UTM6.shp” file 
into your map
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Map Projections



You will notice that your two maps look 
very different. This is because of two 
different projections being used.
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Map Projections

Universal Transverse Mercator (UTM) Projection WGS84 Geographic Projection



1 - in both maps, zoom out to be able 
to see Greenland and Canada
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Map Projections

Universal Transverse Mercator (UTM) Projection WGS84 Geographic Projection



Introduction to GIS using ArcGIS Pro
We will start the session at 9:10 on 
page 19 of ArcGIS Pro Module 3 
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1 - Now zoom out to view the entire 
world
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Map Projections

Web Mercator (UTM) Projection NAD83 UTM Zone 17N Projection
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Projections - WGS 84 

1 - in your first map, right-click on the 
neighbourhoods layer and select 
“Properties”

2 - select the “Source” option in the 
popup

3 - examine the “Spatial Reference” 
information. Take note of the “WKID” 
and the “Datum”



1 - in your second map, right-click on 
the neighbourhoods layer and select 
“Properties”

2 - select the “Source” option in the 
popup

3 - examine the “Spatial Reference” 
information. Take note of the “WKID” 
and the “Datum”. You will notice there 
is also “Projection” information

Projections - NAD 1927 UTM Zone 17 
(EPSG 26717)
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You can compare and get information about thousands of projections at spatialreference.org
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Map Projections
http://spatialreference.org



1 - open the “Catalog” pane

2 - locate the Centreline folder and 
right-click on the 
“CENTRELINE_WGS84.shp” shapefile

3 - look under the “Spatial Reference” 
area

4 - judging by the WKID and 
Geographic Coordinate System, 
should you load this dataset in the 
first or second map?
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Map Projections



1 - go back to your first map by clicking 
on its tab

2 - drag the 
“CENTRELINE_WGS84.shp” shapefile 
into this map
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Attribute Data



1 - right-click the 
“CENTRELINE_WGS84” layer in the 
“Contents” area and select “Attribute 
Table”
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Attribute data



1 - Unanchor the attribute table tab 
outside of the map by hold-clicking on 
the tab and moving it anywhere on the 
screen

Attribute data
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1 - locate the column/field 
“FCOD_DESC”

2 - right-click on the column header 
and select “Sort Ascending”

3 - examine the records by scrolling to 
the bottom of the table and examine 
the entries 

Notice that the entries are in 
categories. We can symbolize our 
entries based on those categories.

27

Attribute data



1 - right-click again on the centreline 
layer and select “Symbology”

2 - in the symbology pop up window 
click on the “Primary symbology” 
option and select “Unique Values”
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Symbolizing data



1 - select the “FCODE_DESC” variable 
for “Field1” in the Symbology popup 
window

2 - click on “Color scheme”

3 - click the “Show names” and “Show 
all” option

4 - select the “Basic Random” colour 
scheme
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Symbolizing data



1 - once your centreline layer has 
drawn, click once in the contents area 
on the line left of the variable 
“Expressway Ramp”

2 - in the “Symbology” popup window, 
click on the “Highway” option
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Symbolizing data



1 - repeat the same operation as on 
the previous page for the 
“Expressway” variable

31

Symbolizing data



1 - repeat the operation for the “Major 
Railway” and “Minor Railway” layers 
but select the “Railroad” option in the 
“Symbology” popup
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Symbolizing data



1 - click on the “River” variable

2 - in the “Symbology” popup type in 
the word “river” in the search box

3 - select the “Water (line)” option

Symbolizing data
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You can also changed just the colour 
of the current symbol

1 - right-click on the “Local” variable

2 - select the colour, “Gray 70%”
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Symbolizing data



1 - click once on the word 
“CENTRELINE_WGS84” above 
“FCODE_DESC” in the “Contents” 
area

2 - rename the layer “Toronto Roads”

3 - click once on the word 
“FCODE_DESC” under “Toronto 
Roads” and rename the variable 
“Streets”
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Symbolizing data



1 - right-click on the “Toronto Roads” 
layer and select “Symbology”

2 - right-click on the “Access Road” 
option and select “Remove” 

Symbolizing data
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1 - remove the following variables in 
the same fashion as in the the last 
operation on page 35:

“Ferry Route”, “Geostatistical line”, 
“Hydro Line”, “Minor Shoreline”, 
“Other”, “Other Ramp” and “Pending” 

NOTE: you can select several 
variables by control-click selecting 
several at one time, then right-clicking 
and selecting “Remove”

Symbolizing data

37



1 - in the “Symbology” pop up, select 
the “More” option tool and unclick 
“Show all other values” to unselect the 
option to display all unformatted 
options (the ones we deleted) 
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Symbolizing data



1 - using the “Catalog” pane, click on 
the “BikeWays” folder and drag the 
“CENTRELINE_BIKEWAY_OD_WGS
84.shp” layer from that folder into your 
map

2 - in the contents area, right-click the 
“CENTRELINE_BIKEWAY_OD_WGS
84.shp” layer and select “Attribute 
Table”
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Creating data 
subsets



1 - in the attribute table, locate the 
“CP_TYPE” column/variable

2 - right-click on the “CP_TYPE” 
column and select “Sort Descending”

3 - scroll down and examine the 
different possible entries for this field

4 - notice the many empty entries?

Creating data 
subsets
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1 - turn the “Toronto Roads” layer off in 
the contents pane

2 - In the attribute table, notice the 
“Bike Lanes” entries in “CP_TYPE” 
column

Creating data 
subsets
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1 - under the “Map” menu option, click 
on “Select By Attributes”

2 - a “Geoprocessing” popup will open

3 - make sure you are selecting 
attributes from the 
“CENTRELINE_BIKEWAY_OD_WGS
84” layer

2 - “Selection Type” should be set to 
“New selection”

3 - click on “Add Clause”

42

Creating data 
subsets



1 - select the field “CP_TYPE” to be 
queried, the option “is Equal to”, and 
the entry “Bike Lanes” using the 
drop-down menu options

2 - Click on “Add” once the expression 
is complete

3 - click on “Run”

Creating data 
subsets
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1 - notice there are 1279 entries 
selected

2 - under “Selection type”, select “Add 
to the current selection”

3 - Click on “Add Clause”

Creating data 
subsets
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1 - using the boolean operator “Or”, 
select the field “CP_TYPE”  that “is 
Equal to” → “Suggested On-Street 
Routes”

2 - click on “Add”
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Creating data 
subsets



1 - click on “Run” in the Geoprocessing 
popup

2 - there should now be 2313 selected 
road segments from the attribute table

3 - your map should show the selected 
entries in pale blue like in your 
attribute table

Creating data 
subsets
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1 - right-click on the bikeways layer in 
the contents pane and select “Data → 
Export Features”

2 - in the “Geoprocessing” popup, type 
in the name “bikeways” for the new 
dataset within the projects 
“geodatabase”

3 - click on “Run”

Creating data 
subsets
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Your map should now include your 
data subset

1 - if your “Catalog” pane is closed, 
open it again by going to the “View” 
menu and clicking on “Catalog Pane”

2 - navigate to the geodatabase by 
going to the “Folders” area of the 
“Catalog” 

3 - navigate to “Loading and 
Manipulating Data.gdb” or whatever 
name you called your project

3 - expand the geodatabase, and you 
should see your “bikeways” layer listed 48

Creating data 
subsets



1 - turn off the original 
“CENTRELINE_BIKEWAY_OD_WGS
84” layer, but keep the new “bikeways” 
layer on
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Creating data 
subsets
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Creating data 
subsets
1 - click on the coloured line 
underneath the “bikeways” layer in the 
“Contents” pane.

2 - in the “Symbology” popup window, 
click on “Properties” and change the 
“Line width” to 2.5pt.

3 - click on “Apply”



1 - remove the original bikeways layer 
by right-clicking on it and selecting 
“Remove”

2 - turn the “Toronto Roads” layer on

3 - right-click on the “Toronto Roads” 
layer and select “Label”

4 - notice the speed (slow) of the 
labeling?
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Labeling 



“Labeling” using default settings can 
be messy. In this case we are lucky at 
least that the software chose the right 
field since it uses the first “text” field it 
found in the table.
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Labeling



1 - right click again on the “Toronto 
Roads” layer and select “Labeling 
Properties”

2 - click on the “Visibility Range” option 
of the “Label Class” popup

3 - select “1:50,000” under the “Out 
beyond” drop down option. This will 
prevent the software from labelling our 
text when it is not useful at “small” 
scale
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Labeling



1 - start zooming in to a larger scale 
than 1:50,000 to see the labels
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Labeling



1 - click on the “Label expression” 
option in the “Label Class” popup

2 - build the following expression in the 
“Expression” box:

$feature.LF_NAME + “ (“ + 
$feature.FCODE-DESC + “)” 

which will create a label from the two 
fields containing the name of the road 
and the type of road.

3 - click on “Apply”
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Labeling



1 - click on the “Symbol” option of the 
“Label Class” popup box

2 - expand the “Appearance” area and 
change the size of the font used for 
your label to 8pt

3 - click on “Apply”
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Labeling



1 - under the “Position” area of the 
popup window again, expand the 
“Placement” option

2 - click on “Allow stacked labels to 
straddle lines”

3 - select “Offset curved”
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Labeling



Now that we have formatted our layer 
the way we want it, we want to be able 
to reuse or share this formatting.

1 - right-click on the “Toronto Roads” 
layer and select “Sharing” → “Save As 
Layer File”

2 - navigate to your “data” folder and 
into the “Centreline” folder

3 - name your layer “Toronto 
Roads.lyrx”

4 - click “Save”

Layer Files
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1 - once your formatting has been 
saved for your “Toronto roads” layer 
right-click on the “Toronto Roads” layer 
and select “Remove”

2 - right-click on the “bikeways” layer 
and select “Zoom to Layer”
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Layer Files



Let’s verify that the formatting we 
created was saved in the layer file.

1 - under the “Map” menu, select “Add 
Data” → “Data”

2 - in the “data” → “Centreline” folders, 
select the “Toronto Roads.lyrx” file

3 - click on “OK”
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Layer Files



1 - to restore the order of our layers 
from before, select the “bikeways” 
layer and move it above the “Toronto 
Roads” layer in the Contents pane

Layer Files
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remember to save your project often
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Saving Projects



1 - in the “Catalog” pane, locate the 
“AP1947” folder

2 - select and load the two files within 
that folder into the map

3 - shift-click and select both air photos 
in the “Contents” pane

4 - while still holding the shift key, 
right-click on one of the two file and 
select “Group”

5 - rename the grouped datasets 
“1947 air photos”
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Grouping datasets



1 - right-click on the “1947 air photos” 
group and select “Zoom to Layer”

2 - you could save the grouping of the 
two datasets in a “layer” file as we did 
previously with the “Toronto Roads” 
layer.
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Grouping Datasets



1 - right-click and remove the “1947 air 
photos” layer group

2 - in your web browser, go to the 
following url: 
https://open.toronto.ca/dataset/web-m
ap-services/ alternatively, go to 
toronto.ca/open, click on the “Open 
Data Catalogue” link and in the search 
box type “Web Map Services”, click on 
the link and click on “Download Data”

3 - click on “VISIT PAGE”

4 - copy the URL from the XML code 
page  that opens
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Mapping Services

https://open.toronto.ca/dataset/web-map-services/
https://open.toronto.ca/dataset/web-map-services/


1 - in ArcGIS Pro, click on the “Insert” 
menu and select “New WMTS Server”

2 - in the “server URL” box, paste the 
link obtained from the open data site: 
“https://gis.toronto.ca/arcgis/
rest/services/primary/cot_ortho

_webm/MapServer/WMTS/”

3 - click on “OK”
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Mapping Services

https://gis.toronto.ca/arcgis/rest/services/primary/cot_ortho_webm/MapServer/WMTS/
https://gis.toronto.ca/arcgis/rest/services/primary/cot_ortho_webm/MapServer/WMTS/
https://gis.toronto.ca/arcgis/rest/services/primary/cot_ortho_webm/MapServer/WMTS/


1 - in the “Catalog” pane, navigate to 
the “Servers” area

2 - expand the 
“primary_cot_ortho_webm” 
connection, expand the “Layers”

3 - select and drag the “City of Toronto 
Imagery” layer into your map

4 - zoom in and out of your map 
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Mapping Services
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Mapping Services
Other WMS sites



Geocoding
1 - in the folder 
“ArcGISProWorkshop/data/Coffee_Sh
ops” double-click on the file, 
“Coffee_TIME_SA.csv” 

Notice there are no geographic 
coordinates attached to this file. There 
are, however, address locations.

2 - close the spreadsheet
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Geocoding
1 - drag the “Coffee_TIME_SA.csv” file 
into the “Contents” pane

You will notice that the table appears 
in the “Contents” pane, but nothing is 
mapped out. In order for our data to be 
mapped out, coordinates need to be 
assigned to each location. A 
“Geocoder” must be used to 
accomplish this task. There are many 
that exist, but ArcGIS Pro uses its own 
proprietary one that requires you sign 
into ArcGIS Online. 
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1 - in the top right corner of the ArcGIS 
Pro screen, click on “Not signed in”

2 - click on “Sign in”

3 - Under, “Your ArcGIS organization’s 
URL, click on “Utoronto”*

*If this option is not listed, click on 
“Enter another Organization”, type 
“utoronto” and click on “Continue, 
select “ArcGIS Online (University of 
Toronto)”

4 - sign in using your UTORid

Geocoding
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Geocoding
1 - in the “Contents” pane, right-click 
on the “Coffee_Time_SA.csv” file and 
select “Geocode Table”

2 - in the “Geocode Table” wizard 
popup, click on “Start → “
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Geocoding
1 - in “Step 1 of 6”, your “Input Table” 
should be “Coffee_Time_SA.csv” and 
your selection for your data to be 
geocoded should be selected as “More 
than one field”

2 - click on “Next →”

3 - select either of the two geocoders 
listed

4 - click on “Next →”

73



Geocoding
1 - if using the “ArcGIS World 
Geocoding Service”, match the fields 
as in this screen capture

2 - if using the “Canadian Geocoder”, 
map the fields as per the second 
screen capture

3 - click on “Next →”
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Geocoding
NOTE:  if using the “ArcGIS World 
Geocoding Service” go to the next 
page

1 - if using the “Canadian Geocoder”, 
click on “Run”

2 - once completed, click on “No” to 
the “Geocoding Completed” popup

3 - close the “Geocode Table” popup 
window
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Geocoding
NOTE: This screen is for those who 
are using the “ArcGIS World 
Geocoding Service” 

1 - select “Address Location” as the 
“Preferred Location Type” in “Step 4”

2 - click on “Next →”

3 - in “Step 5”, click on “Next →”
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Geocoding
1 - click on “Finish → “ in “Step 6”

2 - click on “Run” once the “Guided 
Workflow Complete” popup appears
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Geocoding
1 - in the “Geocoding Completed” 
popup, click “No” to run through the 
“rematch” process

2 - close the “Geocode Table” popup 
window
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Geocoding
1 - click on any of the resulting points

2 - right-click on the generated layer 
“Coffee_Time_SA_Geocoded” and 
select “Attribute Table”

3 - when sliding through the table to 
the right to view all the fields, you will 
notice that the longitude (X) and 
latitude (Y) fields for each entry will be 
listed
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Geocoding with 
Google Earth
One alternative to Esri’s geocoders is 
to use Google to geocode your 
addresses.

1 - In Windows Explorer, open “Google 
Earth Pro”

2 - drag the “Coffee_Time_SA.csv” file 
into “Google Earth”
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Geocoding with 
Google Earth
1 - in the “Data Import Wizard”, select 
“Delimited” for “Field Type” and 
“Comma” under the “Delimited” area

2 - click on “Next >”
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Geocoding with 
Google Earth
1 - make sure the option “This dataset 
does not contain latitude/longitude 
information, but street addresses” is 
turned on

2 - click on “Next >”
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Geocoding with 
Google Earth
1 - map out the “Address Fields” 
according to the spreadsheet column 
names “Street Field” → “Address”;  
“City Field” → “City”, etc.

2 - click on “Finish”
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Geocoding with 
Google Earth
1 - click on “No” when asked to apply a 
template to the file
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Geocoding with 
Google Earth
1 - turn on the “Coffee_Time_SA.csv” 
layer in the “Places” pane in Google 
Earth

2 - click on any of the points
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Geocoding with 
Google Earth
1 - right-click on the 
“Coffee_Time_SA.csv” layer and select 
“Save Place As…”

2 - save your file as 
“Coffee_Time_SA.kmz” in the 
“ArcGISProWorkshop\data\CoffeeSho
ps” folder
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Geocoding with 
Google Earth
1 - from the 
“ArcGISProWorkshop\data\CoffeeSho
ps\” folder, drag and drop the 
“Coffee_Time_SA.kmz” file into your 
map

2 - click on any of the points
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Other Geocoders
Another free geocoder is 
“Geocoder.ca”

To use “geocoder.ca”, simply copy and 
paste addresses in the first screen and 
select an output format

Click on “Geoparse locations from text”
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Other Geocoders
The University of Toronto also 
purchases access to DMTI’s “Location 
Hub” geocoder

A username and password are 
required for access to this service.
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Geocoding with 
QGIS
You can use google, esri or 
openstreetmap as a geocoding service 
to geocode in QGIS
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1 - in Windows, navigate to the the 
“ArcGISProWorkshop/data/lost_brewer
ies” folder

2 - double click on the 
“LostBreweriesToronto.csv” file

Notice there are two columns 
indicating a geographic location using 
latitude, “POINT_X” and a longitude, 
“POINT_Y”

3 - close the file and do not save it
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Displaying XY 
(Coordinate or 
GPS) Data



Displaying XY Data
1 - drag the 
“LostBreweriesToronto.csv” file into 
your map 

2 - right-click on 
“LostBreweriesToronto.csv” in the 
“Contents” pane and select “Display 
XY Data”

3 - make sure the “X Field” is set to 
“POINT_X” and the “Y Field” is set to 
“POINT_Y” and note the name of the 
“Output Feature Class”

4 - click on “Run”
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Displaying XY data
1 - a new feature layer will be loaded 
into your map and saved into your 
geodatabase
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End of Module 3
Workshop evaluation if you do not 
move onto module 4:

http://maps.library.utoronto.ca/feedbac
k.html
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http://maps.library.utoronto.ca/feedback.html
http://maps.library.utoronto.ca/feedback.html

